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Addendum A

Power Up Error Codes For Supersweep 64

The following are the error codes that may show when the
SuperSweep is first powered up.  Some of these codes can
indicate a serious problem with the operation of the
SuperSweep as described below.

ERR 001  RAM Test tests a section of external RAM by writing and
reading back patterns.  It will show ER 001 if the test fails.

ERR 002 PLD Test reads the model and revision from the PLD and
verifies that the model number is in the valid range (1 to 15).
It will show ERR 002 if the test fails

ERR 003 Flash RAM Test reads and verifies the manufacturer code from
both Flash modules.  It will show ERR 003 if the test fails.

ERR 004 Front Panel Test reads the Button state register and verifies
that no buttons are stuck down.  It will show ERR 004 if the
test fails.

ERR 005 Analog Test configures the D to A output zero volts on the Lat
and Long channels and a small positive value on the emission
channel.  The test reads the A to D values from the feedbacks
and checks for a match.  It then applies a small offset to the Lat
and Long positions and reads the offset back from the A to D.
It will show ERR 005 if the test fails.  This test will also fail if
the coil outputs are disconnected from the SuperSweep 64 or if
one or both of the sweep coils are defective (open or shorted).
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Summary of Terms and Conditions of Sale

MECHANICAL WARRANTY: For a period of 
twelve (12) months from the date of original ship-
ment to Purchaser thereof, the apparatus and each 
part or component manufactured by Temescal, part 
of BOC Coating Technology, a division of The 
BOC Group, Inc., hereinafter known as “Seller,” is 
warranted to be free from functional defects in 
materials and workmanship. The foregoing war-
ranty is subject to the condition that the apparatus, 
part, or component be properly operated under 
conditions of normal use, and that regular periodic 
maintenance and service be performed, or replace-
ments made, in accordance with instructions pro-
vided by Seller. The foregoing warranty shall not 
apply to any apparatus, part, or component that has 
been repaired other than by Seller or an authorized 
representative of Seller, or in accordance with writ-
ten instructions provided by Seller; that has been 
altered by anyone other than Seller; or that has 
been subject to improper installation or abuse, mis-
use, negligence, accident, or corrosion.

Purchaser’s sole and exclusive remedy under the 
above warranty is limited to, at Seller’s option, 
repair or replacement of defective parts or compo-
nents, or return to Purchaser of the price of the 
apparatus. Any such obligation on Seller’s part is 
subject to the following requirements:(x) the defect 
must be promptly reported to Seller; (y) if so 
advised by Seller, Purchaser must return the part or 
component with a statement of the observed defi-
ciency not later than seven (7) days after the expi-
ration date of the warranty to the address 
designated by Seller, during normal business hours, 
transportation charges prepaid; and (z) upon exam-
ination by Seller, the part or component must be 
found not to comply with the above warranty. 
Return trip transportation charges for the part or 
component shall be paid by Purchaser. In the event 
that Seller elects to refund the purchase price, the 
apparatus shall be the property of Seller and shall 
be promptly shipped to Seller at Seller’s expense. 
This mechanical warranty shall be void and the 
apparatus shall be deemed to be purchased AS IS 
in the event that the entire purchase price has not 

been paid within thirty (30) days of original ship-
ment of the apparatus. 

THERE ARE NO EXPRESSED OR IMPLIED 
WARRANTIES THAT EXTEND BEYOND THE 
WARRANTY HEREINABOVE SET FORTH. 
THERE IS NO WARRANTY OF MERCHANT-
ABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE WITH RESPECT TO THE APPARA-
TUS OR ANY PART OR COMPONENT 
THEREOF, AND NO WARRANTY SHALL BE 
IMPLIED BY LAW.

Items not of Seller’s manufacture but resold by 
Seller are the products of other manufacturers and 
their warranty, if any, shall apply. THERE ARE 
NO WARRANTIES OF ANY KIND ON PROD-
UCTS OF OTHER MANUFACTURERS 
RESOLD BY TEMESCAL, EXCEPT THE WAR-
RANTY OF TITLE, AND NO WARRANTIES 
SHALL BE IMPLIED BY LAW. THERE IS NO 
EXPRESSED OR IMPLIED WARRANTY OF 
MERCHANTABILITY OR OF FITNESS FOR A 
PARTICULAR PURPOSE WITH RESPECT TO 
PRODUCTS OF OTHER MANUFACTURERS.

PERFORMANCE WARRANTY: Seller warrants 
that the apparatus will comply with the specifica-
tions set forth in the purchase order. All specifica-
tions are subject to the corrections and tolerances 
allowed by the NEC. If the purchase order 
expressly provides for factory testing to verify 
compliance with the specifications, Purchaser shall 
be entitled to witness the testing.  

Seller shall have the right to: (a) witness the field 
testing and to verify the results of such field test-
ing; (b) have free access to all data compiled by 
Purchaser in connection with any field test; and (c) 
conduct its own field test at its own expense during 
any fourteen-day (14-day) consecutive period 
which may be mutually agreed upon by Seller and 
Purchaser; provided, however, that Seller shall 
have the right to field test within six (6) months of 
receipt from Purchaser of any notice of failure to 
comply with the specifications.  If  compliance 



with the specifications is to be demonstrated by 
field testing, Purchaser shall conduct and complete 
all field testing within sixty (60) days of the origi-
nal shipment of the apparatus and shall promptly 
notify Seller of any failure to comply with the  
specifications.  Seller shall not be liable for any 
failure to comply with the specifications demon-
strated by field testing unless it receives notice 
thereof within  sixty-seven (67) days of the date of 
original shipment of the apparatus.

In the event that factory testing or field testing does 
not demonstrate compliance with the specifica-
tions, Purchaser’s sole and exclusive remedy under 
the above warranty is limited to, at Seller’s option, 
repair or replacement of defective parts or compo-
nents or return to Purchaser of the purchase price 
of the apparatus.  In the event that Seller elects to 
refund the purchase price, the apparatus shall be 
the property of Seller.

Any obligations on Seller’s part under this perfor-
mance warranty are subject to the following 
requirements: (x) the nature of the failure of the 
apparatus to comply with the specifications must 
be promptly reported to Seller in writing; (y) if the 
apparatus has been delivered and field tested, Pur-
chaser must return the apparatus or any part or 
component to Seller upon its request, not later than 
sixty-seven (67) days after initial shipment to Pur-
chaser, to the address designated by Seller, during 
normal business hours, transportation charges pre-
paid; and (z) upon examination and testing by 
Seller, the apparatus must be found not to comply 
with the specifications.  Return trip transportation 
charges for the apparatus or any part or component 
shall be paid by Purchaser.  This performance war-
ranty shall be void and the apparatus shall be 
deemed to be purchased AS IS in the event that the 
entire purchase price has not been paid within 
thirty (30) days of original shipment of the appara-
tus.

THERE ARE NO EXPRESSED OR IMPLIED 
WARRANTIES THAT EXTEND BEYOND THE 
WARRANTY HEREINABOVE SET FORTH.  
THERE IS NO WARRANTY OF MERCHANT-
ABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE WITH RESPECT TO THE APPARA-

TUS OR ANY PART OR COMPONENT 
THEREOF, AND NO WARRANTY SHALL BE 
IMPLIED BY LAW.

DISCLAIMER OF LIABILITY: IN NO EVENT 
SHALL SELLER BE LIABLE FOR DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL, OR CON-
SEQUENTIAL DAMAGES ARISING FROM 
ANY SOURCE such as, but not limited to, the 
manufacture, use, delivery (including late deliv-
ery), or transportation of any apparatus, part, or 
component sold to Purchaser, whether such dam-
ages are caused by Seller’s negligence or other-
wise.  Without limiting the generality of the 
foregoing sentence, Seller shall not be liable for: 
the cost of capital; the cost of substitute apparatus, 
services, repairs, components, or parts; loss of 
profit or revenue; the cost of power, whether pur-
chased or produced by the consumer thereof; loss 
of use of the apparatus or any part thereof, or of 
any other property owned by Purchaser; claims or 
costs of Purchaser’s customers; injury to persons, 
or death; or damages to any property.  In the event 
that any limited warranty or disclaimer of liability 
is found to be unlawful or inapplicable, or to have 
failed of its essential purpose, Seller’s liability 
shall be limited to the amount paid by Purchaser 
for the apparatus.



Safety Instructions for Operating and Service 
Personnel

Operators and service personnel should always wear safety glasses.  Operators shall not enter areas 
intended for service access only.  Only experienced service personnel should enter such areas, and only 
after taking the preliminary precautions described in paragraphs 1 through 6 below. 

DANGER: Potentially lethal voltages may exist within this system, even with the main power 
switched off.  Service should only be attempted by qualified personnel.  Failure to observe all safety 
precautions can result in personal injury.

Observe the precautions described below when servicing this system, especially when servicing compo-
nents where high voltages might be present. 

1. Before servicing or operating this equipment, read all the component manuals supplied with the system, 
paying special attention to safety instructions. 

2. Post HIGH VOLTAGE WARNING signs in conspicuous locations within the service area. 

3. Remove rings, watches, bracelets, and any other metal jewelry before working around high voltage. 

4. DO NOT WORK ALONE! Work in a “buddy system” when doing preventative maintenance work.

5. Be sure that all equipment is connected to a power receptacle having the correct polarity and grounding, 
as prescribed by the local electrical codes.  Refer to the power supply portion of the documentation to 
determine the proper electrical ground for high-voltage components. 

6. Before servicing any high-voltage component, switch off the electrical power at the component’s main 
power switch.  This switch must have a lockout feature.  Lock the power off and keep the key with you 
while you are working on the equipment. 

7. Certain electrical parts (e.g., electrolytic capacitors) hold a lethal voltage even after the power is 
switched  off.  Before entering any service area, use a grounding hook to discharge such parts.  Be sure 
that these parts are discharged before starting any repairs. 

8. DO NOT touch high-voltage leads unless power is off and a grounding hook is connected to the parts to 
be serviced. 

9. The high-voltage components of the system should be equipped with electrical interlocks to protect per-
sonnel from injury. 

10. Electro/mechanical components of the system should be equipped with electrical interlocks to protect 
personnel from injury.  DO NOT ATTEMPT TO DEFEAT, OVERRIDE, OR BYPASS THESE PRO-
TECTIVE DEVICES!

11. Never leave loose ends on high-voltage connections.

12. Observe the following warning if the system employs Radio Frequency (RF) power.



DANGER

RF radiation-even at modest power levels-can cause serious injury.  If any of the RF components (e.g., the 
RF power supply, the RF matching network, or the RF electrodes or shielding inside the product chamber) 
are moved or changed in any way, the RF energy may be radiated outside the equipment.  Monitor the 
equipment to assure that external RF radiation is below the levels prescribed by any and all applicable 
safety codes. 



Special Amendment for United Kingdom Users

All Electrical Power Sources:  Safety Precautions

Only authorized personnel should be permitted to carry out work on this system.

Prior to any servicing, grounding hooks should be used to short out all high-voltage parts and conductors in 
both the vacuum system and the high-voltage power supply.  Screens protecting extra-high-voltage con-
ductors should be removed only if appropriate action has been taken to ensure that extra-high-voltage con-
ductors are dead and cannot be reenergized inadvertently.

In addition, all personnel should be aware of:

1. The Electricity (Factories Act) Special Regulations (1908 and 1944), in particular, Regulations 18(d) 
and 28 of the 1980 Regulations, as amended; and

2. The employer’s responsibility to set up suitable systems to safeguard the health and safety of employees, 
according to the Health & Safety at Work etc. Act (1974). 



User Responsibility

This equipment will perform in accordance with the instructions and information contained in the user’s 
manual and its referenced documents when such equipment is installed, operated, and maintained in com-
pliance with such instructions.  The equipment must be checked periodically.  Defective equipment shall 
not be used.  Parts that are broken, missing, plainly worn, distorted, or contaminated, shall be replaced 
immediately.  Should such repair or replacement become necessary,  a telephonic or written request for ser-
vice should be made to Temescal.

The equipment, or any of its parts, shall not be altered without the prior written approval of Temescal/BOC 
Coating Technology.   The user and/or purchaser of this equipment shall have the sole responsibility for 
any malfunction which results from improper use, faulty maintenance, damage, improper repair, or alter-
ation by any party other than Temescal.



Health Hazard

The condensates deposited on the tank walls of a vacuum system are generally in the form of extremely 
fine particles.  The nature, as well as the form, of the materials pose the following potential health hazards: 

a) Inhaling fine particles (powder) may cause damage to the lungs.  To help prevent this, wear a protective 
respirator mask with fine filter that has been approved by the National Institute for Occupational Safety 
and Health (NIOSH) and the federal Mine Safety and Health Administration (MSHA). 

b) Some substances are toxic and inhaling them should be avoided.  Take steps to ascertain whether or not 
the material being deposited is a known toxic substance.  Refer to the Material Safety Data Sheet(s) cov-
ering the evaporant(s) in question.

c) Certain powders (titanium, for instance) can cause flash fires when exposed to oxygen or other oxidiz-
ers.  Therefore, when opening the chamber door after a deposition cycle, exercise extreme caution and 
allow time for the coating surface to oxidize.  Breakage of some of the more reactive condensates may 
be hazardous, even when the above precautions are observed.  In this situation, fire-protective clothing 
should be worn. 
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CHAPTER 1 Overview

The Temescal SuperSweep64 (SS64) provides a range of programma-
ble sweep controls for an electromagnetically deflected electron beam 
source. The SuperSweep64 can store up to 64 pre-defined wave pat-
tern recipes. You can define or modify the recipes on-line using the 
Handheld unit, or off-line on a computer using the SS64 software pro-
gram. Controls include wave pattern selection, amplitude and fre-
quency adjustments, offset and position adjustments, and emission 
current.

The enhancements include:

• 16 bit microprocessor control

• PC Recipe Menu control

• 64 sweep programs or recipes (unlimited on PC)

• user-defined arbitrary waveform

• hand-held remote control

• updatable firmware

A hardware device (the SS64) controls the intensity and pattern of the 
e-beam emission from an e-beam gun. The SS64 can store up to 64 
wave pattern recipes. Your PC can hold more.

Each SS64 contains four predefined waveforms that are provided for 
both lateral (or horizontal x-axis) and longitudinal (or vertical y-axis) 
directions.

• sine

• triangle

• saw tooth

• clipped
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Overview
A total of 16 (4 x 4) waveform combinations can be used to define a 
wave pattern, for example, combinations such as sine (x) and sine (y), 
sine (x) and triangle (y), and so on. 

In addition, a fifth output option allows the creation of an arbitrary 
waveform. This is a user-defined option in which you define the 
shape of the wave pattern.

Furthermore, you can determine the amplitude, frequency, and posi-
tion of the waveform along x- and y-axes. 

SuperSweep Components
The following SuperSweep components:

• SS64 Box

• Hand-Held Remote

• PC Menu

 are discussed in brief below.

SS64 Box

To create a desired sweep pattern, use the controls located on the front 
panel of the SuperSweep box to adjust current amplitude, frequency, 
and position in x- and y-axes. When the desired pattern is set, the user 
can prevent further modification by disconnecting the box’s hand-
held remote. 

Front Panel

Use the Front Panel to turn the E-beam sweep on or off, configure the 
unit control source, select and load a wave pattern recipe from a 
memory location in the unit, and save any changes you make to the 
recipe via the handheld.
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SuperSweep Components
The Front Panel has the following six controls: Sweep Enable, Mode, 
Program Up/Down, Program Load, and Program Save.

Figure 1-1. SS64 Front Panel
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Overview
Figure 1-2. SS64 Back Panel

Hand-Held Remote

The Handheld Remote is a remote controller that allows you to create 
a new recipe or modify an existing recipe’s attributes. 

The Handheld Remote has the following six controls: Emission, 
Waveform, Latitude/Longitude, Position, Amplitude, and Frequency. 

Emission Current Control

Sweep

110/220 VAC

Synchronization In/Out Modify Enable Switch

Interface

RS232 RS485 Coil Drive
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SuperSweep Components
To create a new recipe or modify an existing recipe, select the desired 
option and adjust the value using the dial control. To save changes, 
press Program Save located on the front panel of the SS64 box.

Figure 1-3. SS64 Remote

E-Beam Gun

The SuperSweep 64 controls the movement of the electron beam 
from an E-beam gun by dividing this movement into latitudinal (x-
axis) and longitudinal (y-axis) components. The combination of these 
components determines the position of the beam at any time. 

PC Menu

The SS64 program includes a software component that allows you to:

Select the emission current value
1-100%FS

Select the type of waveform, i.e.,
sine, triangle, sawtooth, clipped,
or arbitrary

Select the latitude (x-axis) and/or
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Select the amplitude or the area
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Overview
• create and simulate wave-pattern recipes off-line

• modify existing recipes (off-line or on-line)

• send a recipe from the PC or laptop to a SuperSweep 64

• get a recipe from the SS64

• control a SuperSweep 64 unit remotely through a serial cable 
connection (RS232/RS485)

Recipe Window

The Recipe window displays when you open the program. Use this 
window when working off-line to create or import new recipes, view 
and modify existing recipes, and save recipe files to disk or to the 
SuperSweep 64 EEPROM.

Figure 1-4. Recipe Window
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SuperSweep Operation
SuperSweep Operation

The programmable sweep produces beam sweep patterns by varying 
the current in the coils of the e-beam source. 

The SS64 is a hardware device that controls the intensity and pattern 
of the e-beam, which is created by an e-beam gun. The SS64 
EEPROM can store up to 64 wave pattern recipes. The following 
options allow you to modify values of the wave pattern (along the x- 
and y-axes):

• wave selection

• amplitude 

• frequency

• position

• emission current

Also, the SS64 system includes a PC software component that allows 
you to create and modify wave pattern recipes and to control the 
SS64 unit remotely. Further discussion on this will follow. 

Definitions
The following SS64 system features and functions are identified and 
defined below.

Amplitude
Amplitude refers to the maximum latitudinal or longitudinal position 
of the waveform. It is displayed as a percent of Full Scale.
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Overview
Arbitrary Wave

For an Arbitrary wave pattern, there is one value for Amplitude that 
represents the largest of either the latitudinal (x) or the longitudinal 
(y) dimension.

Standard Wave

For a Standard wave selection, the latitudinal and longitudinal values 
are independent; therefore, there is a value for the Amplitude of the 
waveform in the x direction and a second independent value for the 
Amplitude in the y direction. The combination of points from both 
axes creates the pattern. 

Arbitrary Wave
In addition to the Standard waveforms, the SS64 includes the ability 
to draw an Arbitrary or random pattern. Select Arbitrary Wave then 
use the mouse to draw the pattern on the Wave Pattern Simulation 
grid.

After drawing, select Redraw to normalize the pattern. The program 
will calculate 1,024 pairs of latitudinal and longitudinal points (x, y) 
that define the wave pattern.

You can change the size of the wave pattern by varying the Ampli-
tude.

You can change the number of times the E-beam sweeps the pattern in 
one second by varying the Frequency and by adding or changing 
Dwell Factors.

You can view the movement of the E-beam over time by selecting 
Simulate. 
8 6/6/02 Temescal SuperSweep



Definitions
Dwell Factors

Arbitrary Waveform

Dwell Factors only apply to Arbitrary waveforms. A Dwell Factor 
refers to a point on the wave pattern where the E-beam holds it’s posi-
tion for a specified period of time. A single Dwell Factor can range 
from 1/1,024 to 63/1,024 of a complete pattern cycle and the system 
allows up to 63 Dwell Factors per pattern. Dwell factor times are pat-
tern cycle frequency dependent.

If you have not specified a Dwell Factor, the E-beam travels the 
waveform pattern at a constant rate of speed. 

The Dwell Factor window shows the Row and Column designation 
for the dwell factor. Row 0 and Column 0 correspond to the lower 
left corner of the grid (-4, -4).

EEPROM
The Erasable Electronic Programmable Read-Only Memory 
(EEPROM) is a non-volitile memory component of the SuperSweep 
64 that provides 64 memory locations for storing waveform recipes. 
Each location corrresponds to a number from 1 to 64. This location 
number uniquely identifies the recipe.

Emission Current
Emission current refers to the intensity of the E-beam and is dis-
played as a percent of maximum (or Full Scale).

Frequency

Arbitrary Wave

For an Arbitrary wave pattern, Frequency is the number of times the 
beam sweeps through the pattern in one second.
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Overview
Standard Wave

For a Standard wave selection, there is a value for the Frequency in 
the latitudinal direction and a second, independent value in the longi-
tudinal direction. Therefore, Frequency refers to the number of times 
the E-beam sweeps through the pattern on the specified axis in one 
second. 

Full-Scale
Full Scale refers to the percent of maximum Amplitude.

On the Wave Pattern Simulation grid, the maximum latitude (x-value) 
is +4 amps and the maximum longitude (y-value) is +4 amps. There-
fore, the value +4 corresponds to 100% Full Scale and 0 corresponds 
to 50% Full Scale. 

Off-Line
Use the PC program independently from the SuperSweep 64 to work 
off-line. In this mode, there is no interaction with the active recipe in 
the SS64.

When you launch the PC program, the Recipe window displays. Use 
this window to work off-line. You can create, view, and modify wave-
form recipes. You can store recipes to PC disk or to a location in the 
SS64.

In off-line mode, the Save action saves the recipe to the PC disk. The 
Send action saves the recipe to a location on the  SS64 EEPROM.

Offset Position

Set the sweep position by selecting a position range from 1 to 255, 
laterally and/or longitudinally.
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Definitions
The center of the Wave Pattern Simulation grid (as shown on the PC 
Recipe menu screen) is defined as the intersection point (128, 128) of 
the x and y axes. Changing the x- or y-coordinate offsets the center of 
the wave pattern and the new coordinates reposition the wave pattern.

On-Line
You are working on-line when you are using the PC program to con-
trol the SS64.

If you select Control/Modify Recipe, the SuperSweep Commands 
window displays. Use this window to work on-line.

You can load a recipe into the SS64, making it the active recipe. You 
can then adjust the PC controls the same way that you would adjust 
controls using the front panel or the handheld.

In on-line mode, the Save action saves any modifications to the active 
recipe to the SS64 EEPROM. The system does not save the modifica-
tions to a file stored on the PC.

See Controlling the SS64 Remotely and Modifying the Active Recipe.

Original Scale Factor

Arbitrary Wave

The Original Scale Factor is only relevant for Arbitray waveforms. 
Original Scale Factor is the percentage of Full Scale, or Amplitude, 
at the time the pattern is first drawn. (For Standard waveforms, the 
Original Scale Factor is always 100.)

The Original Scale Factor displays under the Wave Pattern Simula-
tion grid in the Recipe window. If you modify Amplitude then return 
to the original value, type the Original Scale Factor into the Ampli-
tude field under Wave Selection (Latitude).
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Position Limits
Position Limits for each axis of the Wave Pattern Simulation grid 
define the working area of the grid. The program displays (and the E-
beam moves along) only that portion of the pattern that lies within the 
minimum and maximum Position Limits.

For example, if you want to use only the lower half of a pattern, set 
the maximum Longitudinal Position Limit equal to 0.

Recipe
A recipe is a set of properties that define the intensity and position of 
the e-beam over time. The system executes a recipe to create a wave 
pattern.

When you launch the PC program, the Recipe window displays. Use 
this window to create, modify, and store recipes off-line, and send 
recipes to and retrieve recipes from the SS64.

The active recipe is the recipe that is currently loaded in the SS64. 
You can work on-line to adjust a recipe while it is active in the SS64, 
either via the PC program or using the SS64 hardware controls.

Properties

You can adjust various properties or parameters of the waveform rec-
ipe.

Emission Current controls the intensity of the e-beam while the 
remaining properties define the position of the e-beam over time.

• Position Name - the Recipe property, SS64 Position, uniquely 
identifies the waveform recipe to the PC program and speci-
fies its memory location in the SS64; name is an optional 
field for recipe identification in the PC program only

• Wave Selection - choose a Standard or an Arbitrary waveform 
that is the basis for the e-beam’s pattern of movement. Adjust 
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Definitions
the pattern by modifying amplitude, frequency, offset posi-
tion, and position limits.

• Amplitude - adjust the height and width of the waveform as a 
percentage of full scale

• Frequency - specify the number of times the beam sweeps or 
cycles through x- and y-axes (Standard wave selection) or 
pattern (Arbitrary wave selection) per second

• Offset Position - specify the center position of the wave pat-
tern

• Position Limits - define the relevant area of the Wave Pattern 
Simulation grid

Active Versus Current Recipe

The Active Recipe is the Recipe that is currently loaded into the 
SS64. To modify the Active Recipe, you must work in On-Line 
mode.

The Current Recipe is the Recipe that is displayed in the Recipe win-
dow of the PC program. To modify the Current Recipe, you must 
work in Off-Line mode. 

Standard Wave

Waveforms

The SuperSweep 64 includes four Standard waveforms: Sine, Trian-
gle, Sawtooth, and Clipped. From the Recipe screen, you can select 
one of these waveforms for the latitudinal (x) direction and one for 
the longitudinal (y) direction. This results in 16 possible standard-
wave combinations.

Wave Pattern Simulation

After you have selected the latitudinal and longitudinal waveforms, 
the program generates a static representation of the pattern and dis-
plays it on the Wave Pattern Simulation grid.
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The program generates 1,024 independent x- and y-coordinates based 
on the chosen waveforms. The program then pairs these x- and y-
coordinates according to the remaining recipe parameters to form the 
shape of the completed wave pattern.

Redraw

You can adjust the waveform properties then view the changes using 
Redraw. The Redraw function recomputes the x- and y-coordinates 
according to the current parameters. Because Redraw is a static repre-
sentation, it does not incorporate Frequency. To view the pattern with 
the Frequency parameter included, use Simulate.

Note:   If the Wave Selection is the same in both the latitudinal and 
the longitudinal directions, the combined wave pattern is a 
diagonal line where x = y. To create a more useful wave pat-
tern when the Wave Selection and the Frequency properties 
are equal, the program offsets the longitudinal waveform by 
90 degrees.

Simulate

To view the waveform pattern as it changes over time, select simu-
late. The Simulate function incorporates both Frequency and Dwell 
Factors. If Frequency in both the latitudinal and longitudinal direc-
tions is the same, then the waveform appears the same in both the 
Redraw and Simulate modes. 

Wave Selection

Standard Wave

If you choose to use Standard waveforms, you must select a wave-
form for the X-axis and an independent waveform for the Y-axis. The 
program will combine the two waveforms to create the Wave Pattern. 
The program displays the new wave pattern on the Wave Pattern Sim-
ulation grid.

Arbitrary Wave
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Definitions
To draw an Arbitrary, or random, wave pattern, select the Arbitrary 
Wave Selection, then use the mouse to draw the shape on the Wave 
Pattern Simulation grid. See Create an Arbitrary Pattern.

Latitude and Longitude

From the PC Recipe screen, select one of these waveforms for lati-
tude, x-axis, and one for the longitudinal, y-axis. This results in 16 
possible standard wave combinations.

After selecting the x and y waveforms, a waveform is displayed on 
the Wave Pattern Simulation grid. Independent 1,024 x- and y-coor-
dinates are based on the selected waveforms. The x- and y-coordi-
nates are paired together according to the selected amplitude and 
position, and form the shape of the completed wave pattern.

To change the wave pattern, vary the amplitude and position of the 
waveform on either axis.

Use the Simulate function to see the movement of the e-beam over 
time.

Note:   If the same wave form, amplitude, and position are selected 
for both the x- and y-axis, the y-coordinate is offset by 90 
degrees to form a usable pattern.

Arbitrary Wave

In addition to the Standard waveforms, the SS64 includes the ablility 
to draw a user-defined or Arbitrary pattern. From the PC Recipe 
screen, select the Arbitrary Wave option under Wave Selection Lati-
tude (x-axis) drop down box. Draw a freehand pattern on the Wave 
Pattern Simulation grid.

Note:   Note the number value in the Amplitude field. If needed, you 
can re-enter it later to return to the original value.
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Overview
After drawing the pattern, select Redraw to normalize the pattern. 
Normalizing smoothes out the pattern by calculating 1,024 pairs of (x, 
y) points.

Change the size of the wave pattern by varying the amplitude.

Change the number of times the e-beam sweeps the pattern in one 
second by varying the frequency and dwell factors. 

Selecting Dwell Factors allows you to specify a point or points on the 
pattern where you want the e-beam to pause or dwell for a period of 
time. A dwell factor ranges from 1/1,024 to 63/1,024 of a pattern.

View the movement of the e-beam by selecting Simulate.

Return to the original value of amplitude or when the pattern was first 
drawn by entering the original scale factor into the Amplitude field.

Specifications
The following is a list of specifications for the SS64 box unit and 
hand-held remote.

Maximum amplitude: -/+ 4 amperes on x- and y-axes

Frequency range: 1 to 199 Hz/cycles per second, both axes

Power requirements: 100-240 VAC, 50-440 Hz

The next chapter discusses the installation and configuration of the 
SS64 box and software.
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CHAPTER 2 Installation

This section provides hardware and software installation and configu-
ration instructions for the SS64. The standard hardware installation 
procedures pertain to cabling, setting position interlock limits, and 
rack mounting the SS64 unit.  The hardware configuration instruc-
tions concern the following operational options:

• The unit automatically compensates for changes in the input 
power.  No changes are necessary whether 120-, 220-, 230- or 
240V AC is supplied at 50- or 60-Hz.

• Program selection and the Modify Enable and Sweep Enable 
functions can be controlled by a host computer or some other 
customer-supplied remote switching device.  The unit is fac-
tory-configured to accept contact-closure inputs from such 
devices.  It can be configured to accept +24-VDC inputs.

Objectives for this chapter allow you to:

• Connect the coil-drive cable (See “Connect the Coil-Drive 
Cable” on Page 18.)

• Make remote I/O connections via the interface cable (See 
“Remote Inputs and Outputs” on Page 21.)

• Reconfigure for +24 VDC remote control inputs (See 
“Reconfiguring for +24-Volt Remote Control Inputs” on 
Page 25.)

• Set the limits for the position interlock output (See “Setting 
the Position Interlock Limits” on Page 28.)

• Rack mount the unit (See “Rack Mounting the SS64” on 
Page 30.)

• Install and configure the software (See “Installing and Con-
figuring the Software” on Page 31.)
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Installation
Connect the Coil-Drive Cable
Refer to Figure 2-1 and follow the procedure described below in con-
necting the beam position cable (PN 0040-3740-0 for 20-ft. cable, PN 
0040-3740-1 for 40-ft. cable) to the coil current feedthrough and to 
rear panel connector J2.

1. If necessary, make a hole for the cable in the vacuum cabinet wall 
near the coil current feedthrough.  The hole should be large 
enough to hold a standard electrical box connector or another 
device that will secure the cable and protect it from chafing 
against the edges of the hole.

2. Strip 1/4 inch of insulation off the ends of all four exposed wires.

3. Attach the spade lugs provided with the cables to each stripped 
wire. Hollingsworth crimping tool H-7B is recommended for this 
operation.

4. Attach the electrical box connector or other securing device 
loosely to the cable and remove the nut from the connector. 

5. Insert the cable and connector through the hole in the vacuum 
cabinet wall, screw the nut back onto the connector securely, and 
tighten the connector’s retainer around the cable until it is tight 
enough to prevent the cable from moving through the connector.

Caution:   Do not overtighten this retainer; doing so could short the 
position control circuits.

6. Attach the lugs on the ends of the green-white wire pair to the 
feedthrough terminals for the longitudinal position coil.  (See 
Table 1 for polarity.)

Table 1.  Coil Wiring Position

Color Polarity Function

Green Negative (-) Longitudinal

Position CoilWhite Positive (+)

Red Positive (+) Lateral

Position CoilBlack Negative (-)
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Connect the Coil-Drive Cable
Note:   The white wire must be connected to the positive (+) terminal 
for the longitudinal coil, and the green wire must be con-
nected to the negative (-) terminal for the longitudinal coil.

7. Attach the lugs on the ends of the red-black wire pair to the 
feedthrough terminals for the lateral position coil.

8. Plug the other end of the cable into rear panel connector J2 on the 
programmable sweep chassis and tighten the twistlock.
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Installation
Figure 2-1. Rear Panel Connections

The sweep is configured for
110/220 VAC input power.

110/220-VAC Power 

Sweep Interface Cable
(See Figure 2-2 for I/Os.)

From J2 Pins

4

5

1
2

�
�

Green

White

Red

Black

-

+

+
-

To gun longitudinal coil

To gun latitudinal coil

}

}

Coil Drive Cable

Ground Copper Strap
Connect to vacuum cubicle’s
central grounding point,
which must be connected to
a low-impedance ground. For
instructions on setting up the
low-impedance ground, see
Figure 2-1 of the SimbaTM

Power Supply Manual.
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Remote Inputs and Outputs
Remote Inputs and Outputs

This subsection provides instructions for making connections to 
remote devices via the Sweep Interface cable (PN 0040-4972-0), 
which plugs into rear panel connector J1.  Figure 2-2 shows the color 
coding and the pinouts for the wires in this cable and provides speci-
fications for the inputs and outputs. 

Except for the Position Interlock output, which is required by most 
electron beam power supplies, these remote I/Os are optional.  How-
ever, if no remote Modify Enable input is provided, the red-black 
wire pair provided for this function must be jumpered, or the operator 
will not be able to modify sweep programs with the hand-held con-
troller.  

In addition, the yellow-black wire pair for the Sweep Enable input 
must be jumpered if other remote control functions--but not remote 
Sweep Enable--are implemented.  

If the Sweep Enable loop is not closed, either by remote input or by 
jumpering of the yellow/black wire pair, the beam will not sweep 
when the rear panel Local/Remote Switch is set to Remote.
Temescal SuperSweep 6/6/02 21



Installation
Figure 2-2. Remote I/Os Via the Sweep Interface Cable
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Remote Inputs and Outputs
Functional Description of Remote I/Os

Table 2. Remote I/Os

Input/Output Description

Modify Enable If this loop is not closed, the hand-held controller is disabled.  This function can 
be enabled by con-tact closure or a +24 VDC signal from a host computer or 
some other customer-supplied switching device.  Such a device can then be 
used to prevent undesired modification of the sweep programs.

NOTE

If no remote input is provided, the red-black wire pair for this line MUST be 
jumpered together, or programs cannot be modified.

Sweep Enable A normally-open contact closure or a +24 VDC signal can be used to enable the 
beam sweep.  When this line is not enabled, the beam is controlled only by the 
position parameters of the beam sweep program currently selected.

NOTE

If you are not implementing this function but are implementing other remote 
control functions, the yellow-black wire pair for this line MUST be jumpered 
together.  If this loop is not closed--either by remote input or by the jumpering 

of these wires--the beam does not sweep.

Select 1, Select 
2, Select 3

These input lines allow the user to imple-ment remote program selection.  The 
inputs must be either normally-open contact closures or +24 VDC signals, and 
they must be coded according to the binary-coded-decimal scheme. See Coding 
for Program Selection Inputs, following this table.

Position Inter-
lock Output

This normally-open contact closure signals the system’s electron beam power 
supply that the longitudinal coil current is within the set limits (see subsection 
2.5).  If the power supply is a Simba 2, connect these wires to the yellow-red 
wire pair in the Gun Control-System I/O cable, which plugs into rear panel con-
nector J2 on the Simba gun control unit.

CAUTION

If you are supplying this output to a Simba 2 power supply, it is also neces-
sary to remove the position PC board for the gun controlled by this 

sweeper from the Simba gun interface.  Failure to do so may result in the 
power supply receiving a false interlock signal and consequent damage to 

the electron beam gun.
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Installation
Connecting I/O Lines to Remote Devices
Follow the procedure described below in connecting the remote I/O 
lines.

1. Plug the Sweep Interface cable into rear panel connector J1 and 
tighten the twistlock.

2. Referring to the descriptions above, determine which remote 
functions you wish to implement.

3. Refer to Figure 2-2 to determine which wires to connect for the 
desired function.

4. Connect the appropriate wires to the appropriate device(s).

Longitudinal 
Coil Current 
Output

This 0 to +10 VDC signal tracks the +/- 4 A current that the sweep provides to 
drive the electron beam gun’s longitudinal coil.  This output allows a remote 
device to monitor and/or display the lateral coil current.

Lateral Coil 
Current Output

This -10 to +10 VDC signal tracks the +/- 4 A current that the sweeper provides 
to drive the electron beam gun’s lateral deflection coil.  This output allows a 
remote device to monitor and/or display the lateral coil current.

Coding for Program Selection Inputs

Program 
Number

Select 3 
Signal

Select 2 
Signal

Select 1 
Signal

1 0 0 0

2 0 0 1

3 0 1 0

4 0 1 1

5 1 0 0

6 1 0 1

7 1 1 0

8 1 1 1

Table 2. Remote I/Os

Input/Output Description
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Reconfiguring for +24-Volt 
5. If one or more of the control inputs is to be +24 VDC, follow the 
procedure described in subsection 2.3 to reconfigure control PC 
board #1 for the +24 V input(s).  Note the polarities for +24 V 
inputs indicated in Figure 2-2.

6. If you are not implementing remote Modify Enable, jumper the 
ends of the red-black wire pair together.

Note:   If no input is provided and these wires are not jumpered, 
sweep programs cannot be modified.

7. If you are implementing remote program selection and/or remote 
Modify Enable, but not remote Sweep Enable, jumper the ends of 
the yellow-black wire pair together.

Note:   If no input is provided and these wires are not jumpered, the 
beam does not sweep.

Reconfiguring for +24-Volt Remote Control Inputs
Any of the remote control inputs described previously can be either a 
contact closure or a +24 VDC signal.  For each 24V signal supplied, 
a jumper block on the main PCB must be reconfigured.  Upon remov-
ing the chassis top cover, locate the jumper blocks in question toward 
the rear on the left side in front of the DB37 connector, J2.  See the 
following figure.  The jumper blocks are arranged as follows: J7, J8, 
J10, J9, J11, with J7 nearest the PCB edge.  Jumper blocks J8, J10, 
and J9 are for program selection lines Select 1, Select 2, and Select 3, 
respectively.  J7 is for the Modify Enable line, and J11 is for the 
Sweep Enable line (shown as Select 4 on the schematics).

To reconfigure a given jumper block:

• Remove the chassis top cover, if you have not already done 
so.

• Find the correct jumper block for the signal in question.
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Installation
• Remove the three jumpers connecting pins 1 and 2, 3 and 4, 
and 5 and 6.

• Replace two of the jumpers so that they connect pin 2 to pin 3 
and pin 4 to pin 5.

Refer as needed to the SuperSweep assembly drawing and the Main 
PCB schematic Sheet 6.
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Reconfiguring for +24-Volt 
Figure 2-3. SS64 Printed Circuit Board

Jumper
Blocks

Position
Interlock
Potentiometers
Temescal SuperSweep 6/6/02 27



Installation
Setting the Position Interlock Limits
Follow the procedure described below in setting the upper and lower 
limits for the position interlock contact closure, which must be output 
to the electron beam power supply for the source controlled by this 
SuperSweep unit.    All appropriate installation configuration proce-
dures outlined in the preceding section must be completed before this 
procedure is performed.  The SuperSweep Position Interlock Limits 
have been factory set to limit the beam position to +/-4 amperes on 
both axes. Potentiometers R214 through R217 provide these limit 
adjustments. There are also software position limits discussed later in 
this manual.

Caution:   Before beginning this procedure, make sure that the posi-
tion interlock signal is interfaced to the correct power sup-
ply.  If the source is powered by a Simba 2 power supply, 
make sure that:

1. the position interlock output is provided to the gun con-
trol unit for the source whose beam is controlled by the 
SuperSweep unit

2. the position PCB is removed from the gun interface 
chassis

1. Make sure that the hand-held remote is plugged into the RJ-85 
connector on the front panel of the SuperSweep.

2. Remove the unit’s top cover, if you have not already done so.   
Refer to the preceding figure for potentiometer R214 through 
R217 locations.

3. Plug in the SuperSweep’s power cord and turn on the Power 
switch on the front panel.  The displays illuminate, and the 
Amplitude bar-graph displays show the position of the beam and 
any sweep activity. If there is sweep activity occurring, press the 
Sweep Enable button to stop the sweep.  The green indicator light 
on the button dims when the sweep is disabled.

4. Using the hand held remote, press the Latitude/Longitude select 
button so that the Longitude indicator light displays.
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Setting the Position Interlock 
5. Press the Position button, and turn the Adjust knob to move the 
Longitude bar-graph display indicator to the Zero position.

6. Press the Latitude/Longitude button again to select Latitude, and 
then center the Latitude display as done previously for the Longi-
tude.

7. Note that the Position Interlock indicator on the front panel is not 
illuminated.

8. Find the gun control for the source controlled by the SuperSweep 
and set the Filament Request to 0 amperes.

9. Switch on the high voltage and the emission current for this 
source. If you look at the source through a viewport, you should 
see the filament glowing and possibly a faint beam.  If you can-
not see a beam, slowly increase the filament current request until 
a beam is barely visible.

Caution:   Damage to the source or to other equipment inside the 
vacuum chamber is likely if any more than minimum 
power is used to obtain a visible beam for this procedure.

10. Rotate the Adjust knob clockwise and note the lateral movement 
of the beam in the positive current direction.  Move the beam up 
to the edge of the pocket and then turn off the emission current 
and high voltage. Note the current reading on the SuperSweep 
front panel. 

11. Using a small potentiometer adjusting tool, rotate potentiometer 
R214 counterclockwise until the Position Interlock indicator just 
comes on.  Slowly turn the Adjust knob counterclockwise until 
the Position Interlock indicator dims, then turn it back clockwise 
until the Position Interlock displays. Note that the current reading 
on the SuperSweep panel matches the previously noted value.  If 
not, slightly adjust R214 so that the Position Interlock illumina-
tion point coincides with the current value.

12. Once set, reset the current back to zero.

13. Switch on the high voltage and emission current for this source 
again, repeating Step 9.
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Installation
14. Rotate the Adjust knob counterclockwise and note the lateral 
movement of the beam in the negative current direction.  Move 
the beam up to the edge of the pocket and then turn off the emis-
sion current and high voltage. Note the current reading on the 
SuperSweep front panel.  

15. Using a small potentiometer adjusting tool, rotate potentiometer 
R215 clockwise until the Position Interlock indicator just comes 
on.  Slowly turn the Adjust knob clockwise until the Position 
Interlock indicator dims, then turn it back counterclockwise until 
the Position Interlock re-displays. Note that the current reading 
on the SuperSweep panel matches the previously noted value.  If 
not, slightly adjust R215 so that the Position Interlock illumina-
tion point coincides with the current value.

16. Once set, return the current back to zero.

17. Press the Latitude/Longitude button to select Longitude.

18. Repeat the above procedure (Steps 9 through 16) for the longitu-
dinal beam position setpoints, adjusting potentiometer R216 for 
the positive current direction, and potentiometer R217 for the 
negative current direction.

19. Replace the SuperSweep top cover.  The unit is now ready for 
mechanical installation and software based configuration.

Rack Mounting the SS64

Follow the procedure described below in mounting the SS64 in a 
standard 19-inch rack.  If your installation requires access to the unit’s 
PC boards, rack mount the unit as the final step in the installation.

1. Unplug the unit’s power cable.

2. Disconnect the coil drive cable and the sweep interface cable 
from their rear panel connectors.

3. Disconnect the hand-held controller’s cord from the front panel 
jack.
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Installing and Configuring the 
4. Set the sweeper into the rack and secure it in place with mounting 
screws.

5. Reconnect the hand-held controller’s cord, the sweep interface 
cable, and the coil drive cable.

6. Connect the rear-panel GND lug to the central grounding point in 
the vacuum cubicle with a length of 1/2-inch-wide copper strap.  
The central grounding point MUST be properly connected to a 
low-impedance ground (for instructions see Figure 2-1 in the 
instruction manual for the SimbaTM 2 Power Supply.

Note:   The SS64 may fail to operate properly if the low-impedance 
ground is not established correctly, particularly in systems 
that generate relatively large amounts of RF noise.

7. Plug in the unit’s power cable.

The SS64 is now ready for initial operation.

Installing and Configuring the Software

Install the SS64 software from the CD.

Centering the SS64 E-Beam

Before performing a sweep operation, you must first position the e-
beam over the center of the crucible using the Recipe Menu window.

Note:   Use the Recipe Menu window (computer interface to the SS64 
box) to set the position values for the e-beam. (You may also 
use the handheld remote to set the e-beam values but the coils 
need to be connected first before the front panel values can be 
displayed [not recommended].)

Set the e-beam position to the following values:
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Installation
• latitude position, x-axis: 0 (0.0 amps)

• longitude position, y-axis -1.1(-1.1 amps)

Set the position limits to the following values

• latitude, x-axis, minimum: -1.80

• latitude, x-axis, maximum: 1.80

• longitude, y-axis, minimum:1.80

• longitude, y-axis, maximum:0.0

Caution:   Do not exceed 0.0 on maximum. Damage to e-gun and cru-
cible may occur.
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CHAPTER 3 Features and 
Functions

This section provides you with a discussion of the features and func-
tions of the SS64 box control/display and software. The SS64 box 
control and display functions and software are identified and defined. 
Furthermore, the following tasks and procedures provide examples on 
how to use the SS64 features and functions to perform specific sweep 
tasks. Objectives for this chapter allow you to:

• Identify and define SS64 features and functions (See “SS64 
Box Unit and Remote Control, Features and Functions’’on 
Page 35.)

• Identify and define PC menu features and functions (See “PC 
Menu Features and Functions’’on Page 40.) 

➹ See program information (See “View the Program Version 
Information’’on Page 41.)

➹ Set up communications (See “Set Up Communications’’on 
Page 41.)

➹ Close the PC menu (See “Close the PC Program’’on 
Page 48.)

➹ Center SS64 e-beam (See “Centering the SS64 E-
Beam’’on Page 48.)

➹ Create a new recipe (See “Create a New Recipe’’on 
Page 49.)

➹ Create a standard pattern (See “Create a Standard Pat-
tern’’on Page 49.)

➹ Create an arbitrary pattern (See “Create an Arbitrary Pat-
tern’’on Page 51.)

➹ Edit an arbritrary pattern (See “Edit an Arbitrary Pat-
tern’’on Page 52.)
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Features and Functions
➹ Redraw a recipe wave pattern (See “Redraw a Recipe 
Wave Pattern’’on Page 53.)

➹ Simulate a wave pattern (See “Simulate a Wave Pat-
tern’’on Page 55.)

➹ Set dwell factors (See “Set Dwell Factors’’on Page 56.)

➹ Import/export an arbitrary pattern (See “Import/Export an 
Arbitrary Pattern’’on Page 57.)

➹ Save a recipe (See “Save a Recipe’’on Page 61.)

➹ Open a recipe file (See “Open a Recipe File’’on Page 62.)

➹ Modify a recipe (See “Modify a Recipe’’on Page 62.)

➹ Send a recipe to the SS64 (See “Send a Recipe to the 
SuperSweep 64’’on Page 63.)

➹ Get a recipe from the SS64 (See “Get a Recipe from the 
SuperSweep 64’’on Page 63.)

➹ Control the SS64 remotely (See “Control the SS64 
Remotely’’on Page 64.)

➹ Install a firmware upgrade (See “Install a Firmware 
Upgrade’’on Page 69.)
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Features and Functions
Features and Functions
This section identifies and defines the SS64 box and software fea-
tures.

SS64 Box Unit and Remote Control, Features and 
Functions

The SS64 box unit and remote control allow you to:

• Load and save a program (recipe)

• Modify and save a program

• Select manual or remote modes of operation

• Connect one or more computers to the SS64 (through an 
RS232 or RS485 connection)

• Select predefined and user-defined (arbitrary) waveforms

• Select latitudinal and longitudinal amplitude, frequency, and 
position

• Adjust emission current for each waveform

SS64 Front Panel
A waveform and its values, e.g., x- and y-axes amplitude, frequency, 
and/or position value, determines the wave pattern characteristics. 
For example, you can select a sine waveform for both x- and y-axes 
with the values of 100% of full scale (FS) amplitude with 10 cycles 
per second frequency at a position offset at - 0.5 amperes on the x-
axis and + .25 amperes on the y-axis.
Temescal SuperSweep 6/6/02 35



Features and Functions
Figure 3-1. SS64 Box, Front Panel

Recipes or programs can be loaded, modified, or created to perform 
specific types of sweeps. Load a recipe by using the SS64 load pro-
gram option, modify a recipe using the remote options, or create a 
new recipe by using the recipe menu on your PC.

You can load and modify a recipe using the SS64 box and remote. 
Select one of the stored recipes in the SS64 box by pressing the up or 
down arrow on the box’s front panel and then select load program. 
The recipe or program number appears in the program number dis-
play. The amplitude and frequency values appear on the x- and y-axes 
and lateral (latitudinal) and longitudinal frequency displays.

Longitudinal (vertical) frequency display

Waveform option

-  Sine
- Sawtooth
- Triangle
- Clipped
- Custom

Program number display

Lateral (latitudinal) frequency display Mode options: Sweep enable

Modify enable

Focus interlock

light

Load program

Save program

Remote plug-in

Power switch

light

light

lights (left to

(1-199 Hz cycles per second)

(1-199 Hz cycles per second)

right):

- Manual
- Remote
- RS232 (single box connection)
- RS485 (multiple box connections, 1-63 units)

Amplitude longitude, y-axis
(1-100%FS)

Amplitude latitude, x-axis
(1-100%FS)

Increment

Decrement
program
number

program
number
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SS64 Box Unit and Remote Control, Features and Functions
Table 1. SS64 Front Panel Features and Functions

Feature Function

Power Switch This is the on and off switch for the SS64 box.

Focus Interlock The Focus Interlock light is displayed once the e-beam focus or emission current 
has been set. Bending the electron beam so that it strikes the material to be evapo-
rated is the function of the focus circuits. The focus interlock prevents the applica-
tion of filament power and high voltage unless the longitudinal focus current is 
within the desired limits.

Modify Enable The Modify Enable light is displayed once the Modify Enable Switch is enabled on 
the the SS64 back panel. When enabled, this feature allows a recipe to be modified 
by either the Handheld Remote or the PC Recipe Menu.

Sweep Enable The Sweep Enable button toggles the e-beam sweep on or off.

Increment Program/Recipe The up arrow allows you to increment or navigate up a series of increasing recipe 
numbers.

Decrement Program/Recipe The down arrow allows you to decrement or navigate down a series of decreasing 
page numbers.

Load Program Once a recipe number is selected, you can press the Load Program button to load 
the recipe.

Save Program After a recipe’s settings are modified on the Handheld Remote or PC Recipe 
Menu, you can save the recipe by pressing the Save Program button.

Program Number This display shows the number of the current recipe in operation.

Remote (Plug-In) Connect your Handheld Remote to the Remote plug-in. You can modify a program 
or recipe by using the Handheld Remote or the PC Recipe Menu.

Mode Mode options allow you to run the SS64 in the following modes:

• manual - control through the front panel

• remote - remote control through legacy connector located on back panel

• RS232 (single SS64 connection) - control by PC through RS232 serial connec-
tion

• RS485 (mulitiple SS64 connections, 1-63) - control by PC through RS485 
serial connection

Longitudinal Frequency The Longitudinal Frequency display shows the vertical frequency value (1-199 Hz 
cycles per second) that was selected on the Handheld Remote or PC Recipe Menu.

Latitudinal Frequency The Latitudinal Frequency display shows the horizontal frequency value (1-199 Hz 
cycles per second) that was selected on the Handheld Remote or PC Recipe Menu.

Waveform Options The type of waveform light displays depending on the type of waveform selected 
(i.e., Sine, Sawtooth, Triangle, Clipped, or Custom/Arbitrary) on the Handheld 
Remote or PC Recipe Menu.
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Features and Functions
Figure 3-2. SS64 Box, Back Panel

Handheld Remote

A remote control is used to select a specific waveform’s amplitude, 
frequency, and/or position value for the x- and y-axes. Select the 
desired waveform attribute and adjust the attribute value by using the 

Amplitude Longitude, Y-axis This vertical bar displays the amplitude value (1-100% of full scale) that was 
selected on the Handheld Remote or PC Recipe Menu.

Amplitude Latitude, X-axis This horizontal bar displays the amplitude value (1-100% of full scale) that was 
selected on the Handheld Remote or PC Recipe Menu.

Position Limits The x- and y-axis coordinates are displayed on the horizontal and vertical bar dis-
plays. These coordinates were selected using the Position and Position Limits fea-
tures on the Handheld Remote or PC Recipe Menu. The combination of x- and y-
axis position coordinates determines the shape of the wave pattern.

Table 1. SS64 Front Panel Features and Functions

Feature Function

Emission Current Control

Sweep

110/220 VAC

Synchronization In/Out Modify Enable Switch

Interface

RS232 RS485 Coil Drive
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SS64 Box Unit and Remote Control, Features and Functions
Dial Control. These values can be saved as a new recipe or program 
by pressing Save Program located on the SS64 front panel. The 
remote can access 8 of the SS64’s recipes at a time.

Figure 3-3. SS64 Handheld Remote

E-Beam Gun
The SS64 controls the movement of the e-beam gun by dividing this 
movement into horizontal (latitudinal or x-axis) and vertical (longitu-
dinal or y-axis) components. The combination of these components 
determines the position of the beam at any time.

Select the emission current value,
1-100%FS, to control the strength

Select the type of waveform, i.e.,
sine, triangle, sawtooth, clipped,
or arbitrary, in the x- and y-axis

Select the latitude (x-axis) and/or
longitude (y-axes) to blend

Select the position (-4 to 4) of the 
wave pattern along the x- and
y-axes

Select the amplitude (1-100% FS) 
along the x- and y-axes served
by the sweep

Select the frequency of cycles per
second (1-199 Hz) that the e-beam

Dial control 

sweeps over the wave pattern

of the emission current

Note: To create an arbitray
waveform, you must use the PC
Recipe Menu

horizontal and vertical waveforms
into a wave pattern (shown on
the Wave Pattern Simulation grid
of the PC Recipe Menu window)

Note: To modify position limits, you
must use the PC Recipe Menu
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PC Menu Features and Functions
The PC or recipe menu also allows you to load, modify, create, and 
save a recipe or program from your PC. You can store an almost 
unlimited amount of recipies on your PC.

The SuperSweep Recipe Menu screen allows you to:

• View the program version information

• Set up communications

• Connect a single SS64

• Connect a network of SS64 units

• Create a recipe

• Open a recipe

• Modify and save a recipe

• Send a recipe to and get a recipe from the SS64

• Control the SS64 remotely

• Install a firmware upgrade

Figure 3-4. Recipe Menu
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PC Menu Features and Functions
View the Program Version Information
To find out what version of the PC program you are running:

1. From the Help menu select About. The About SuperSweep 64 
window displays.

2. Select OK to close the window. 

Set Up Communications
The SuperSweep 64 has two serial ports: a RS-232 port (female) for 
connecting directly to a PC, and a RS-485 port (male) for connecting 
multiple units in a daisy-chain configuration.

The following topics describe how to set up communications 
between your PC and one or more SuperSweep 64 units:

• PC to a single SS64

• PC to a network of SS64 units

Data Transfer Specifications

• Port Selection - COM1, COM2, COM3, or COM4)

• Baud Rate - 9600

• Parity - None

• Data Bits - 8

• Stop Bits - 0

• Receive Buffer Size - static 512 Bytes

• Transmit Buffer Size - static 512 Bytes

See SS64 Hardware and Resolve Connection Problem sections.

Connect a Single SS64

The following topic describes how to set up communications 
between your PC and a single SuperSweep 64.

Hardware Connection

1. On the SS64, set the Mode to RS-232.
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Features and Functions
2. Using a 9-pin serial cable, connect a COM port on your PC to the 
RS-232 port (female) on the SuperSweep 64.

PC Settings

After connecting the PC to the SuperSweep 64, you must configure 
the PC program communications settings to coincide with your hard-
ware connection.

To configure the PC communications settings:

1. From the Comms menu, select Setup. The following dialog dis-
plays:

Figure 3-5. Setup Serial Port

2. From the PC Com Port drop-down box, select the port to which 
your RS-232 cable is connected.

3. After verifying that your PC is connected to the SS64, select the 
RS232 radio button. The program attempts to connect to the 
SS64.

4. If the connection is successful, a dialog box similar to the one 
below displays.

Figure 3-6. Confirm Serial Port Connection
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PC Menu Features and Functions
5. Select OK, then select Close.

See Network of SS64 Units and Resolve Connection Problem sec-
tions.

Connect a Network of SS64 Units

It is possible to network several SS64 units in a daisy-chain configu-
ration using RS485 protocol. You will then be able to control these 
units, one at a time, from a single PC. 

Assigning Addresses (Slave IDs)

The first step is to connect the PC to a SS64 and assign that unit a 
unique address. You must repeat this procedure for each SS64 to be 
connected.

1. On the SS64, set the Mode to RS232.

2. Using a 9-pin serial cable, connect a COM port on your PC to the 
RS232 port (female) on the SS64.

3. Open the SS64 PC program. From the Comms menu, select 
Setup.

The following dialog displays.

Figure 3-7. Setup Serial Port

4. From the PC Com Port drop-down box, select the port to which 
your RS-232 cable is connected.

5. After verifying that your PC is connected to the SS64, select the 
RS232 radio button.

The program attempts to connect to the SS64.
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6. If the connection is successful, a dialog box similar to the one 
below displays.

Figure 3-8. Serial Port Connection Confirmation

7. Select OK.

8. Select Assign 485 Address...

The following dialog box displays.

Figure 3-9. Set RS485 Address

9. Enter an Address (also known as Slave ID). Addresses can be any 
number from 2 to 64.

10. Enter a Description.

11. Select OK. The program sets the address.

12. Disconnect the SS64. Repeat the entire process (Steps 1 through 
12) for each SS64 that you plan to connect.

Configuring the Network

After assigning an address for each SS64, you are ready to configure 
the network. For this step, you will need a RS485 converter and 
RS485 cable.

1. Connect the RS485 converter directly to a Com port on the PC. 
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2. Use RS485 cable to connect the converter to the RS485 port 
(male) of the SS64 units in a serial, daisy-chain configuration. 
(The RS485 port is located below the RS232 port.)

3. Turn on each SS64 in the network and set the Mode to RS485.

Using the Network

You can now use the PC to control any SS64 in the network. How-
ever, you can only communicate with one unit at a time. You must 
tell the program which unit you wish to communicate with.

1. Open the SS64 PC program. From the Comms menu, select 
Setup.

The following dialog displays.

Figure 3-10. Setup Serial Port

2. From the PC Com Port drop-down box, select the port to which 
your RS485 converter is connected.

3. After verifying that your PC is properly connected to the RS485 
network, select the RS485 radio button. The program connects.

4. If the connection is successful, a dialog box similar to the one 
below displays.

Figure 3-11. Serial Connection Confirmation
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5. Select OK.

6. Choose the Select 485 Address button.

The program presents a drop-down list of the Slave IDs 
(Addresses) for each SS64 on the network.

7. Select a Slave ID.

The program makes the connection with the selected SS64. You 
can now communicate with this unit using the PC controls.

See Single SS64 and Resolve Connection Problems sections.

Resolve Connection Problems

For instructions on how to set up the connection between the PC and 
one or more SS64 units, see Setup Communications.

If the program is unable to connect to the SS64, the following dialog 
box displays.

Figure 3-12. Unable to Connect Message

If you do not need to connect to the SS64, select OK then select 
Close. 

If you do need to connect to the SS64, you must resolve the connec-
tion problem. 

Connection to One SuperSweep 64 (RS232)

To resolve a connection problem, verify that:

1. You are using a RS232 cable and that it is connected to the RS232 
port (female) on the SS64.
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2. The COM port you have selected coincides with the actual hard-
ware connection.

3. The Mode selector on the SS64 is set to RS232.

4. After resolving the connection problem, re-select the R-232 radio 
button. A dialog box similar to the one below should display.

Figure 3-13. Serial Connection Confirmation

5. Select OK, then select Close.

Connection to Multiple SuperSweep 64 Units (RS485)

To resolve a connection problem, verify that:

1. The RS485 converter is connected to a PC COM port and that 
you have selected this COM port in the PC communications 
Setup window.

2. The RS485 cable is connected to the RS485 port (male) on each 
SS64.

3. The Mode selector on the SS64 units is set to RS485.

4. Each SS64 in the network has a unique address (Slave ID). 

5. After resolving the connection problem, re-select the RS485 
radio button. A dialog box similar to the one below should dis-
play.

Figure 3-14. Serial Connection Confirmed

6. Select OK, then select Close.
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See Setting Up Communications, Connecting a Single SS64, and Con-
necting Multiple SS64 Units.

Close the PC Program
To close the PC program:

• From the File menu select either Close or Exit. Alternately, 
click the X in the upper right corner of the screen.

Centering the SS64 E-Beam

Before performing a sweep operation, you must first position the e-
beam over the center of the crucible using the Recipe Menu window 
to prevent the beam from over-sweeping the standard temescal 
pocket. (An ampere of 0 positions the beam at the rear of the pocket.)

Note:   Use the Recipe Menu window (computer interface to the SS64 
box) to set the position values for the e-beam. (You may also 
use the handheld remote to set the e-beam values but the coils 
need to be connected first before the front panel values can be 
displayed. This method is not recommended.)

Set the e-beam position to the following values:

• latitude position, x-axis: 0 (0.0 amps)

• longitude position, y-axis -1.1(-1.1 amps)

Set the position limits to the following values

• latitude, x-axis, minimum: -1.80

• latitude, x-axis, maximum: 1.80

• longitude, y-axis, minimum:1.80

• longitude, y-axis, maximum:0.0

Caution:   Do not exceed 0.0 on maximum. Damage to e-gun and cru-
cible may occur.
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Create a New Recipe

Off-Line

When you launch the SS64 PC program, the Recipe window dis-
plays. Use this window to create, import, view, or modify Recipes 
off-line.

To create a new recipe off-line:

1. From the File menu, select New.

2. Enter the SS64 Position. The SS64 Position identifies the Recipe 
to the SS64 and specifies its location in memory.

3. Enter a Name, if desired. This field is optional.

4. Choose a Wave Selection for the latitudinal (x) and the longitudi-
nal (y) directions.

5. Enter the properties of the desired waveform.

• If you choose Standard waveforms, a static representation 
displays on the Wave Pattern Simulation grid.

• If you choose an Arbitrary waveform, you must draw the 
wave on the grid using the mouse, then select Redraw to set 
the x and y coordinates for the pattern.

6. Select Simulate to view the E-beam in motion.

On-Line

You cannot create a new Recipe on-line; however, you can modify 
Recipes that are already stored in the SS64.

Create a Standard Pattern
The SuperSweep 64 includes four Standard waveforms: Sine, Trian-
gle, Sawtooth, and Clipped. To create a wave pattern, select a wave-
form for both the latitudinal and the longitudinal directions. This 
results in 16 possible standard-wave combinations. You can adjust 
the individual waveform properties to create the desired wave pat-
tern.

To create a wave pattern from the Standard waveforms:
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1. From the File menu, select New. The Recipe screen displays.

2. Enter the SS64 Position.

3. Enter a Name, if desired.

4. From the Wave Selection (Latitude) list box, select any waveform 
except Arbitrary.

5. From the Wave Selection (Longitude) list box, select any wave-
form.

6. Adjust the following waveform properties as desired for both the 
Latitudinal and Longitudinal directions:

• amplitude

• frequency

• position

• emission current

• position limits

7. Select Redraw or press Enter to effect the changes.

The resulting static wave pattern displays on the Wave Pattern Simu-
lation grid. To see the effect of Frequency, select Simulate.

Figure 3-15. Standard Pattern - Sine
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Note:   If the Wave Selection is the same in both the latitudinal and 
longitudinal directions, the combined wave pattern is a diago-
nal line where x = y. In order to create a more useful pattern 
when the Wave Selection and the Frequency properties are 
equal, the program offsets the longitudinal waveform by 90 
degrees. 

Create an Arbitrary Pattern
In addition to the four Standard waveforms, the SS64 provides the 
capability to draw or import a random or Arbitrary wave pattern.

To create an Arbitrary wave pattern:

1. From the File menu, select New. The Recipe screen displays.

2. Enter the SS64 Position.

3. Enter a Name, if desired.

4. From the Wave Selection (Latitude) list box, select Arbitrary.

The Wave Selection (Longitude) list box and the Amplitude and 
Frequency fields become unavailable. The Draw Pattern radio 
button on the Wave Pattern Simulation grid is selected.

5. Using the mouse, draw a pattern on the Wave Pattern Simulation 
grid. If you wish, you may edit the pattern.

6. Select Redraw to set the (x, y) points that define the pattern.

7. Adjust the following properties as desired:

• amplitude

• frequency

• position

• emission current

• position limits

8. Select Redraw after editing to effect the changes.
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9. The resulting static wave pattern displays on th Wave Pattern 
Simulation grid. The static waveform properties are Waveform, 
Amplitude, Offset Position, and Position Limits.

Figure 3-16. Arbitrary Wave Pattern

10. Set Dwell Factors if desired.

11. Select Simulate to view the E-beam motion. The Simulate func-
tion incorporates both Frequency and Dwell Factors.

12. Select Clear if you wish to delete the drawing and reset the wave 
properties to their default values.

Edit an Arbitrary Pattern
To edit a previously drawn Arbitrary wave pattern:

1. Locate the Arbitrary wave pattern that you wish to edit.
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2. Select the Edit Pattern radio button to enable edit mode. The fol-
lowing warning message displays.

Figure 3-17. Edit Pattern Warning

If you wish to set dwell factors for this pattern, do so after complet-
ing your edits.

3. Select Yes.

4. Use the mouse to edit the pattern. The edit must have a start point 
(mouse-down) and end point (mouse-up) located on the original 
pattern.

5. Select the Redraw button.

The software calculates the points on the original pattern closest 
to the start and end points, removes all points in between, inserts 
the newly drawn points, and recalculates the waveform’s 1,024 
points. Any previously existing dwell factors are removed. 

6. If you wish to make multiple edits, repeat Steps 2 through 5 for 
each mouse-down/mouse-up event.

7. After all changes are comlpete, re-enter dwell factors if desired.

Redraw a Recipe Wave Pattern

What is Redraw

The Redraw function recomputes the x- and y-coordinates for a wave 
pattern using the current wave properties. Because Redraw is a static 
representation, it does not incorporate time factors such as Frequency 
or Dwell Factors. To view the pattern with these time parameters 
included, use Simulate.
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Arbitrary Wave

When initially creating an Arbitrary wave, you must first draw the 
pattern then select Redraw to set the points that define the pattern.

For more information, see Create an Arbitrary Pattern.

Arbitrary and Standard Wave

Once you have created a Wave Pattern, you can alter the wave proper-
ties then use Redraw to recreate the pattern using the current proper-
ties.

Using Redraw

To use the Redraw function:

1.  Create a new Recipe or retrieve an existing Recipe.

2. Alter one or more of the waveform properties.

3. Select Redraw (or press Enter).

4. The adjusted wave pattern displays on the Wave Pattern Simula-
tion grid.

Note 1:   If the Wave Selection is the same in both the latitudinal and 
longitudinal directions, the combined Wave Pattern will be a 
diagonal line where x = y. In order to create a more useful 
Wave Pattern when both the Wave Selection and the Fre-
quency properties are equal, the software offsets the longitudi-
nal waveform by 90 degrees. For example, a Sine, Sine 
combination yields a circle instead of a diagonal line.

Note 2:   If the Frequency is the same in both the latitudinal and longi-
tudinal directions, the Wave Pattern displayed in both the 
Redraw and Simulate modes is the same. 
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Simulate a Wave Pattern

What is Simulate

The Wave Pattern Simulation grid displays a static representation of 
the wave pattern. The Simulate function displays the movement of 
the E-beam over time.

Note:   If the Frequency in both the latitudinal and longitudinal direc-
tions is the same, then the wave appears the same in both the 
Redraw and Simulate modes.

Using Simulate

To Simulate the E-beam motion:

1. Create a new Recipe or retrieve an existing Recipe.

2. In the Recipe window under the Wave Pattern Simulation grid, 
select Simulate.

3. The E-beam displays on the Wave Pattern Simulation grid as a 
red circle tracing a black path along the pattern.

Figure 3-18. E-Beam Simulation

4. To end the simulation, select Simulate again. 
Temescal SuperSweep 6/6/02 55



Features and Functions
Set Dwell Factors

Arbitrary Wave

Dwell Factors only apply to Arbitrary waveforms. A Dwell Factor is 
a point on the wave pattern where the E-beam holds it’s position for a 
specified period of time. A single Dwell Factor can range from 1/
1024  to 63/1024 of the pattern cycle time. You can enter a maximum 
of 63 Dwell Factors.

To set Dwell Factors:

1. Create a new or retrieve an existing Recipe. The Recipe must use 
the Arbitrary Wave Selection.

2. In the Recipe window above the Wave Pattern Simulation grid, 
select Set Dwell Factors.

Figure 3-19. Set Dwell Factors

3. Double-click a location on the pattern. The Dwell Factor window 
displays.

If the message, "There are no points on the curve within this 
region" displays, select OK and retry.
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4. Enter a Dwell Factor. Since the standard dwell time is 1 (1/1024 
of a pattern cycle time), enter a number from 2 to 63.

Figure 3-20. Dwell Factor

5. Select OK. A red square displays to indicate the presence of a 
Dwell Factor.

Figure 3-21. Dwell Point

6. Select Simulate if you wish to view the E-beam moving along the 
pattern

Import/Export an Arbitrary Pattern
After creating an Arbitrary waveform, you may wish to precisely edit 
the points that define the pattern. With the Import/Export feature, you 
can export the pattern as a text file (*.txt), open the file in any text 
editor and edit the values, then import the file and view the revised 
waveform.
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Note:   The import/export feature is available only for Arbitrary 
waveforms, and is best used without dwell factors. 

How It Works

When you Export the wave pattern, the program writes the pattern 
data to a text file (*.txt). The file consists of 1,024 pairs of x (latitudi-
nal) and y (longitudinal) coordinates with values ranging from –4.000 
to + 4.000. Any existing dwell factors are converted to simple x,y val-
ues. For example:

Let's say that you have a dwell factor of 50 located at the point 
x=2, y=1. When you export the file, the program still exports 
1,024 points but the dwell factors are removed and you see 50 
pairs of x=2, y=1. When you import the file, there are no dwell 
factors. 

After exporting the pattern, you can open the file using any program 
(such as Notepad or Excel) that can read *.txt files. You are able to 
edit the x, y values as desired. 

When you import the edited pattern, you can run the Simulator to ver-
ify your changes. The program does not recalculate your point values 
upon import. However, if you use Edit Pattern, Redraw, or add Dwell 
Factors, the program recalculates values.

Note:   Important! The program removes all Dwell Factors during the 
import/export process. Do not add dwell factors after import-
ing your edited wave pattern; the program regenerates a new 
set of 1,024 points and your edits are lost. If you need to use 
dwell factors, add them before exporting.

Export

To export an Arbitrary wave pattern:

1. Select or create an Arbitrary wave pattern.
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2. From the File menu, select Export. The Open window displays 
with the name of the current Recipe file in the File name field.

Figure 3-22. File Menu

3. Select Open. The program exports the recipe as a text file.

Editing a Text File

To edit your exported text file:

1. Open a program, such as Notepad or Excel, that can read *.txt 
files.

2. Open the text file you previously exported. The file looks some-
thing like this, containing 1,024 pairs of x and y values:

Figure 3-23. Text File Sample
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3. Edit the x, y values as desired. Remember that these values can 
range from -4.000 to +4.000. Do not change the Index values.

4. Save your changes and close the file.

Import

To import a text file of an arbitrary wave pattern, the file must be in 
the format described above.

1. In the SuperSweep 64 PC program from the File menu, select 
Import. An Open window displays. 

Figure 3-24. File Menu

2. Highlight the text file that you wish to import and select Open.

The imported recipe displays in the SS64 PC program.

3. To verify that the recipe is correct, select Simulate. The program 
does not recalculate point values upon import.

Note:   If you use Edit Pattern, Redraw, or add Dwell Factors, the pro-
gram regenerates the x,y values and your edits are lost.

Dwell Factors

The program removes all dwell factors during the import/export pro-
cess. Do not add dwell factors after importing your edited wave pat-
tern; the program will regenerate a new set of 1,024 points and your 
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edits are lost. If you need to use dwell factors, add them before 
exporting. See How It Works for more information.

Save a Recipe

Save a New Recipe to a PC File

The Save and Save As functions save a new Recipe to a PC file loca-
tion. If the recipe file does not yet exist, the Save function displays 
the Save As window.

To save the current Recipe to a file on your PC:

1. From the File menu, select Save or Save As.

2. A Save As window displays.

3. Enter the desired PC file location in the Save In field.

4. Type a file name in the File Name field. Recipe files are saved in 
the format *.rcp.

5. Select Save.

6. The Recipe is saved on the PC in the specified location.

Save Modifications to a Recipe to a PC File

To save changes to an existing Recipe file:

From the File menu, select Save. The program saves the changes 
to the existing Recipe file on the PC in the previously specified 
location.

Save a Recipe to the SuperSweep 64 (Send)

The Send function saves the current Recipe from the PC to the SS64 
EEPROM.

Note:   Before attempting to send a Recipe to the SS64, verify that 
your PC is properly connected to the SS64.

To save the current Recipe to a location in the SS64:
Temescal SuperSweep 6/6/02 61



Features and Functions
1. From the File menu, select Send. A confirmation dialog box dis-
plays.

2. Select Yes to send the Recipe. The Recipe is stored in the SS64 
EEPROM in the SS64 Position specified in the Recipe.

3. If the message, "Failed to Send Recipe. (Communication Time-
out.)" displays, check hardware connections and retry. 

Open a Recipe File
To open a Recipe file that has been stored on the PC:

1. From the File menu select Open. The Open dialog box displays.

2. Locate and highlight the desired file.

3. Select Open. The program opens the file and displays the Recipe 
parameters on the Recipe screen. 

Modify a Recipe

Off-Line

You can modify Recipe files stored on the PC while working off-line.

To modify a Recipe off-line:

1. Retrieve an existing Recipe file.

2. Alter one or more of the waveform properties.

3. Select Redraw (or press Enter). The adjusted wave pattern dis-
plays on the Wave Pattern Simulation grid.

4. If desired, select Simulate to view the E-beam in motion.

5. From the File menu, select Save. The program saves the modifi-
cations to the existing Recipe file.

6. If you want to store the modified recipe in the SS64, from the File 
menu, select Send.
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On-Line

You can modify the Recipe that is currently active in the SS64 while 
working on-line. To perform on-line modifications, see Control the 
SS64 Remotely.

Send a Recipe to the SuperSweep 64
The Send function sends the currently displayed recipe to the SS64.

Note:   Before attempting to send a Recipe to the SS64, verify that it 
is properly connected to the PC.

To send the current Recipe to a location in the SS64:

1. From the File menu, select Send. A confirmation dialog box dis-
plays.

2. Select Yes to send the Recipe. The Recipe is stored in the SS64 
EEPROM in the SS64 Position location specified in the Recipe.

3. If the message, "Failed to Send Recipe. (Communication Time-
out.)" displays, check hardware connections and retry.

Get a Recipe from the SuperSweep 64
The Get function retrieves a Recipe from the SS64 and makes it the 
current Recipe in the PC program.

Note:   Before attempting to retrieve a Recipe from the SS64, verify 
that it is properly connected to the PC.

To retrieve a Recipe from a location in the SS64:

1. From the File menu, select Get. A selection dialog box displays.

2. Enter the SS64 Position for the Recipe you wish to retrieve.

3. Select OK. The Recipe is copied from the SS64 EEPROM and 
displayed in the Recipe window.

4. If the message, "Cannot get select recipe. (Communication Time-
out.)" displays, check hardware connections and retry. 
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Control the SS64 Remotely

Controlling the SuperSweep 64 with the PC

The SS64 PC program allows you to load, control, and modify a rec-
ipe remotely. The PC controls mimic the controls on both the Front 
Panel and the Handheld unit. You can load a Recipe into the unit, 
view the current settings, enable the Sweep, modify the sweep, and 
save the modifications as changes to the Recipe.

Note:   Before attempting remote control of the SS64, verify that:

• your PC is properly connected to the SS64

• the Mode control on the Front Panel is set correctly (RS232 
for a single connection or RS485 for a network)

Accessing the PC Controls

The software provides PC Front Panel Controls, PC Handheld Con-
trols, and a Current Settings display.

To access the PC controls:

From the Control menu, choose Modify Recipe. The Modify/
View Current Recipe window displays.

Front Panel Controls (PC)

The PC program provides Load Recipe, Save Current Recipe, and 
Sweep Disable/Enable functions that mimic these controls on the 
Front Panel of the SS64.

Note:   Before attempting remote control of the SS64, verify that:

• your PC is properly connected to the SS64

• the Mode control on the Front Panel is set correctly (RS232 
for a single connection or RS485 for a network of SS64 units)

To access the PC Front Panel control functions:
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From the Control menu, choose Modify Recipe. The Modify/View 
Current Recipe window displays. The Front Panel controls are 
located on the left.

Figure 3-25. Modify/View Current Recipe

Load Recipe

To use the PC control functions, you must first load a Recipe into the 
SS64.

To load a Recipe using the PC:

1. From the Control menu, choose Modify Recipe.

2. In the Modify/View Current Recipe window under Front Panel 
Controls, select Load Recipe. The Load Recipe Control window 
displays.

3. Type a recipe location ID (SS64 Position) and select OK. The 
Recipe stored in the selected location becomes the active Recipe 
in the SS64.

Sweep Disable/Enable

When you load a recipe, the Sweep is enabled. If you wish to control 
the SS64, remain in the Sweep Enable mode. If you choose to disable 
the Sweep, you can still modify the loaded Recipe and/or view the 
Current Settings.
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To disable/enable the Sweep using the PC:

1. From the Control menu, choose Modify Recipe.

2. In the Front Panel Controls under Sweep Control, select either the 
Disable or the Enable option. The SuperSweep 64 sweep is either 
disabled or enabled.

Save Current Recipe

You can modify the currently loaded recipe using the PC Handheld 
Controls then save these changes to the EEPROM memory in the 
SS64.

To save modifications:

1. From the Control menu, choose Modify Recipe. The Modify/
View Current Recipe window displays. 

2. Modify the Recipe as desired.

3. Under Front Panel Controls, select Save Current Recipe. The sys-
tem saves the changes to the current Recipe in the proper memory 
location in the SS64 EEPROM. 

Handheld Controls

The PC program provides Emission, Wave Select, Frequency, Ampli-
tude, and Offset functions that mimic the controls on the Handheld 
unit.

Emission

Adjusts the strength of the Emission Current up or down.

Wave Select X, Wave Select Y

Toggles through the Standard wave selection choices in the latitudinal 
(x) and longitudinal (y) directions.

You cannot select an Arbitrary waveform using the Handheld Con-
trols. To create an Arbitrary waveform, use the Create Recipe func-
tion in the PC program.
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If an Arbitrary waveform has been loaded, you are not able to change 
the waveform selection. If you wish to activate the waveform selec-
tion control, you must load a Standard waveform into the SS64.

In addition, when a waveform has been loaded, you cannot change 
the waveform type. That is, you cannot change from Arbitrary to 
Standard, or from Standard to Arbitrary.

Frequency X, Frequency Y

Adjusts the Frequency in hertz in the latitudinal (x) and longitudinal 
(y) directions. If you have loaded an Arbitrary waveform, a change to 
Frequency x or Frequency y applies to both axes.

Amplitude X, Amplitude Y

Adjusts the Amplitude in percent of full scale in the latitudinal (x) 
and longitudinal (y) directions.

If you have loaded an Arbitrary waveform, a change to Amplitude x 
or Amplitude y applies to both axes.

Offset X, Offset Y

Adjusts the center position in the latitudinal (x) and longitudinal (y) 
directions. (Functions the same as the Position control in the Recipe 
window.)

To Use the PC Handheld Controls

Before attempting remote control of the SS64, verify that:

• your PC is properly connected to the SS64

• the Mode control on the Front Panel is set correctly (RS232 
for a single connection or RS485 for a network of SS64 
units)

To use the PC Handheld Controls:

1. From the Control menu, choose Modify Recipe. The Modify/
View Current Recipe window displays. The Handheld Controls 
are located on the right side of the screen.
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2. Load a Recipe. TheSweep is enabled upon loading the Recipe. 
You can disable/enable the sweep as desired.

3. Adjust the parameters up or down as desired. 

View the Current Settings

To view the settings for the currently loaded Recipe:

1. From the Control menu, choose Modify Recipe. The Modify/
View Current Recipe window displays.

2. Select View Current Settings. The current settings display. If you 
modify the current Recipe, the system displays your changes. 

Modify the Active Recipe Using the PC Controls

You can modify the settings of the Active, or currently loaded, Recipe 
with or without the Sweep enabled. Your changes display under Cur-
rent Settings.

To modify the currently loaded Recipe using the PC:

1. From the Control menu, choose Modify Recipe.

2. Load a Recipe into the SS64. When a Recipe is loaded, the Sweep 
is enabled. You may disable the Sweep if desired.

3. Adjust the waveform parameters using the PC Handheld Con-
trols. The changes display under the Current Settings. If the 
Sweep is enabled, the changes are reflected in the movement of 
the E-beam.

4. If you wish to save the modifications, select Save Current Recipe. 
The system saves the changes to the current Recipe in the proper 
memory location in the SS64 EEPROM.

5. To save the changes to PC disk, see Get a Recipe from the SS64.
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Install a Firmware Upgrade

1. From the Comms menu, select Firmware Upgrade. The File 
Open dialog box displays.

2. Find and highlight the program file. The upgrade file has the 
extension *.s19.

3. Select Open. The SS64 PC program downloads the new Firm-
ware and updates your system. 
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CHAPTER 4 Theory of Operation

The electron beam gun filament is placed out of the line-of-sight of 
the source crucible to prevent ion bombardment and contamination.  
Bending the electron beam so that it strikes the material to be evapo-
rated is the function of the focus circuits.  The magnetic fields neces-
sary for positioning the beam are provided by controlled currents in 
the longitudinal and lateral focus coils as well as by one or more per-
manent magnets in the electron beam gun.  The longitudinal focus 
current also controls an electron gun controller interlock.  This pre-
vents the application of filament power and high voltage unless the 
longitudinal focus current is within the desired limits. 

The Sweep Control System
The beam control system controls the position and sweep of the elec-
tron beam in both the lateral (x) and longitudinal (y) directions.  In 
any given sweep pattern, there are seven parameters of concern:

• lateral position

• longitudinal position

• lateral sweep frequency

• longitudinal sweep frequency

• lateral sweep amplitude

• longitudinal sweep amplitude

• amplitude of emission current

The SS64 sweep control stores a maximum of 64 sweep programs 
and the seven parameters can each have independent values in each of 
the 64 programs.  Part of the function of the sweep controls is to keep 
these parameters separately stored in a non-volatile memory; they are 
stored on power down.
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The sweep control consists of a control section that drives a firmware 
and software controlled waveform generator and two power amps.  
One power amp drives the lateral coil, the other drives the longitudi-
nal coil.

The control section has a microprocessor and support circuitry that 
includes FLASH RAM, SRAM, decoding circuits, and buffers.  The 
firmware in the control system determines the operating mode of the 
electron beam sweep control based on the external control inputs or 
computer control.  The inputs in the remote (non-computer) mode 
select the program number, sweep on or off, and Modify Enable 
mode.  Each input is optically isolated and buffered before reaching 
the control section.

The handheld controller provides parameter adjustments. The Modify 
knob turns a digital pot.  The digital pot has no stop in either the 
clockwise or counterclockwise direction.  As the pot is rotated, it puts 
out a pair of signals (in quadrature).  The phase relationship of these 
two signals tells the control system in which direction the pot is being 
turned.  The pot modifies a particular sweep parameter -- stored in 
RAM -- if the Modify Enable external input mode is selected.  If the 
system is not in Modify Enable mode, the pot does not have any 
effect.

The display section of the sweep control is driven by the control sys-
tem.  Sweep programs #1 through #64 can be displayed.  In addition, 
the longitudinal and lateral sweep frequencies are displayed (0 to 199 
Hz). 

The control system is disabled under the condition that the 5 volt 
power supply is not at the proper value, i.e., above 4.8 volts DC.  A 5 
volt monitor circuit performs this function. 

The heart of the SS64 is a 16 bit Motorola MC68HC16 microproces-
sor (U16).  The microprocessor provides all of the control functional-
ity in conjunction with a Programmable Logic Device (PLD) U44.  
This PLD operates as a state machine to select and control the various 
internal and external functions of the SS64.
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Firmware that generates the microprocessor program is contained in 
FLASH RAMs.  

U36 contains the executable program code, and U37 is used to retain 
the program and parameter settings for each of the 64 program reci-
pes available to the SS64 operator.  SRAMs U40 and 41 are used to 
provide dynamic memory for normal operation. A 16 bit wide data 
architecture is used throughout the SS64, with the low byte (data bits 
0-7) used for the waveform data information that drives the output 
quad DAC U31.  The high byte is used for all of the control functions 
within the SS64.

On initial turn-on of the SS64, a system reset is generated by U25.  
The microprocessor then sends a ~CSBOOT command and loads the 
firmware program from U36. A self check diagnostic routine is per-
formed, and error codes (if any) are displayed on the front panel dis-
play.  After the diagnostic check is performed, the SS64 parameters 
that were present at the last power-down are loaded into the system 
from U37.  The SS64 then starts normal operation.  

In normal operation, octal bus interface chips U26,27,28,29,30,38, 
and U39 perform data bus switching and transfer from commands 
received from the microprocessor and state machine. Front panel dis-
play and control functions are accessed and controlled using the high 
byte data lines (8 through 15) and address lines 0 through 4.

External data entry is accomplished through control of the bus and 
connection with the external interface points. The external interface 
points include the sweeper interface connector on the rear panel, the 
hand-held remote controller, and two serial ports (RS-232 and 
RS485). U29 provides the interface for the rear panel sweeper inter-
face digital control inputs.  U30 provides the interface for the hand-
held remote controller. Quad 2 to 1 line multiplexer U1 selects either 
the RS-232 transceiver U35 or the RS-485 Transceiver U3 to provide 
external communications with a PC.

The output section consists of both digital and analog components. 
Quad DAC U31 generates three analog outputs, Latitude Sweep 
Drive, Longitude Sweep Drive, and Emission Current Drive.   The 
Latitude and Longitude Sweep Drive signals are sent to bias offset 
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amplifiers U21A and B. U21 generates a negative offset to the analog 
drive voltages to offset the 0-10V signal generated by DAC U31. This 
offset allows the DAC to drive the sweep output amplifiers U42 and 
U43 with a bipolar signal with adjustable offset.  U42 and U43 are 
commercial audio amplifier circuits with 68-watt output capability, 
and are operated at a maximum output of 32 watts at full deflection. 
In addition to driving the output amplifiers, the DAC sweep outputs 
are used to generate analog signals for the Peak Lateral and Longitu-
dinal Current monitor circuits comprised of Op-Amps U19 and U20.  

Current viewing resistors R121 andR139 are used to generate feed-
back to provide signals to several circuits. One circuit is the Lateral 
and Longitudinal Upper and Lower interlocks that provides an inter-
lock that opens when either output current exceeds a preset level to 
prevent damage to an electron gun crucible if the electron beam 
strikes anything other than the pocket. This circuit is comprised of 
Op-Amp U23 and voltage comparators U13 and U14. U13 and 14 
have open collector outputs and all four sections are in a wired OR 
configuration so that if any one section is activated, Transistor Q1 is 
turned off, thus opening relay K1 and opening the interlock.

The second use of the feedback signals is to drive A to D converters 
on the display PCB, which in turn provide the LED Sweep Position 
display indication.

Quad DAC U31 also provides a 0 to 10V signal to drive a suitable 
external Emission Request input on a typical E-Gun power supply 
system.
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